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WEEK ONE         DATE: …………………. 

TOPIC: GRAPHS  

Definition: A graph can be defined as a pictorial way of representing data which had been in tabular 

form.  

A graph can also be referred to as a Chart. There are different types of graphs namely:  

(i) Line graph 

(ii) Bar chart 

(iii) Pie-chart  

(iv) Histogram etc. 

 

CREATING GRAPHS IN MICROSOFT EXCEL 

LINE GRAPH 

Line graph is used to display trends over time. To create a line chart, execute the following steps. 

1. Type in the desired range of values such as the highlighted values in the diagram below and select 

the range A1:D7. 

2. On the Insert tab, in the Charts group, choose Line, and select Line with Markers. 
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Result: 

 

 

 

BAR CHART 

A bar chart is the horizontal version of a column chart. Bar charts illustrate comparisons among 

individual items. They are used when we have large text labels. 

To create a bar chart, follow these steps: 

1. Select the range of values such as those in cell A1:B6 below. 

2. On the Insert tab, in the Charts group, choose Bar, and select Clustered Bar. (Indicated with black 

arrow) 
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Result 

 
 

EVALUATION 
1. What is line graph? 

2. Differentiate between line graph and bar chart. 

 

PIE CHART 

Pie chart is a graph whose values are displayed as a percentage of the complete pie. They are used 

when there is only one data series to be plotted. To create a pie chart, do the following: 

1. Select the range of data to be used for the chart: such as A1:D2 as shown in the diagram below. 

2. On the Insert tab, in the Charts group, choose Pie, and select Pie. 
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Result: 

 
 

HISTOGRAM 

Histogram is a chart representing a frequency distribution; heights of the bars represent observed 

frequencies. In other words a histogram is a graphical display of data using bars of different heights. 

Usually, there is no space between adjacent Bars.  

To create a histogram table, follow these steps: 

1. Type and select the desired range of values (such as the values given below) 

87 20 

27 40 

45 60 

62 80 

3 
 

52 
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20 
 

43 
 

74 
 

61 
 

2. Click on Data tab and then click Data Analysis  

 
3. In the Data Analysis dialog box, click Histogram, and then click OK. An input range box should 

appear. 

 
4. In the Input Range box, type A1:A10. 

 
5. In the Bin Range box, type B1:B4. 

6. Under Output Options, click New Workbook, select the Chart Output check box, and then click 

OK. 

 

EVALUATION 

1. Define Graph? 
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2. List the types of graphs you know? 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. State the steps required in creating the following: 

(i) Line graph 

(ii)  Pie chart 

(iii) Bar Chart  

(iv) Histogram 

2. Explain Histogram. 

 

READING ASSIGNMENT 
Melrose Computer studies for Junior Secondary School 3 pg 64. Practical Session 1 

 

WEEKEND ASSIGNMENT 

1. …….. is a pictorial way of representing data which had been in tabular form. A.  Picture   

B.  Graph  C. Worksheet D. All 

2. …….. is a type of graph A.  Pie Chart   B.  Pie Sheet C.  Translator D. Work 

3. MS Excel is an example of ……. program  A.  Graph  B.  Binary  C. Spreadsheet D. Chart 

4. Plotting of graph in MS Excel is done through the ……..ribbon  A. Insert   B.  Page Layout  

C.  File  D. All 

5. Intersection of a row and column in MS Excel is called …….A. Intersect   B.  Cell  C. Worksheet 

D. Chart 

  

THEORY  

1. What is the difference between line chart and pie chart? 

2. Apart from Microsoft Excel, mention two other examples of spreadsheet programs. 

 

 

WEEK TWO         DATE::…………………. 

TOPIC: EDITING AND FORMATTING GRAPHS (PRACTICAL) 

Editing Graphs in MS Excel 

Graphs can be edited to change or add information that can make them easy to understand and 

explain. Information such as graph title, axis titles, legends etc and be modified. 

1. How to edit the graph title  

 Double click on the graph title area and notice the cursor blinking. 

 Type in the new title at the insertion point and click save. 

2. How to edit the graph axis title  

 Double click the axis title area of the graph and notice the cursor blinking. 

 Type in the new axis title at the insertion point and click save. 

3. How to edit the graph legend 

Graph legends are keys used to interpret the data presentation on the graph. To edit the legend 

color: 

 Double click on the item of the legend to be edited 

 Click on Format menu 

 Navigate to the ‘current selection’ area and click on the drop down arrow. Select Legend 

from the list of options. 

 Click on ‘shape fill’ and select the desired color. 

4. How to edit the graph data values 

The data values can be edited straight from the worksheet and the change is automatically 

reflected in the graph. This means that the graph will be automatically re-plotted with the new 

values. 
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Formatting Graphs in MS Excel 

Graph formatting involves adding some attributes to a graph to make it more presentable and 

attractive. These include changing some of the following: fonts of titles or texts, font size, color, 

boldface, italicizing titles, underlining titles etc. 

1. How to change the style or theme of the graph 

 Double click on the graph and select your desired style under ‘Chart Styles’ group in the 

‘Design’ tab. 

 

 

 

 

 

 

 

 

2. How to change the font of titles or texts on the graph 

 Click on the title label or text  

 Click on the ‘Home’ tab or menu 

 Navigate to the ‘Font’ group section and select the desired font from the drop down list.  

 

3. How to change the font size of texts on the graph 

 Click on the text or title  

 Click on the ‘Home’ tab or menu 

 Navigate to the ‘Font’ group section and select the desired font size from the drop down list.  

 

4. How to change the font color of texts on the graph 

 Click on the text or title  

 Click on the ‘Home’ tab or menu 

 Navigate to the ‘Font’ group section and select the desired font color from the drop down list.  

 

 

 

 

 

 

 

 

Graph title  

Graph legend  

 

 



Name: ___________________________________________________                      Class: ____________ 

GSS/2NDTERM/JSS 3/COMPUTER STUDIES Page 8 
 

EVALUATION 

1. What is the difference between editing and formatting a text? 

2. State the steps involved in changing the color of a text? 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. What are the steps required to edit the title of a graph? 

2. Mention five tabs/menus available in the MS Excel environment 

3. Which of the tabs/menus allows one to change font color or size? 

4. List four types of charts in Excel 

5. Which of the charts display values as a percentage of the complete pie? 

 

READING ASSIGNMENT 

Melrose Computer Studies for Junior Secondary Schools 3 Pg. 64 

 

WEEKEND ASSSIGNMENT 

1. ………can be edited to change or add information that can make them easy to understand and 

explain. A. Worksheet B.  Graph  C.  Workbook  D. Workchart 

2. Graph………. involves adding some attributes to a graph to make it more presentable and 

attractive. A.  Formatting B.  Copying C.  Designing D. All 

3. ………illustrate comparisons among individual items. A. Bar chart B. Scatter chart  C. Line Chart 

D. All 

4. Different kinds of chart styles can be selected under the……..tab/menu A.  Home B.  Design  

C.  Layout  D. All 

5. A …….. contains a matrix of rows and columns.  A. Worksheet  B.  Ribbon  C.  Tab  D. Graph 

 

THEORY 

1. State steps required to edit graph legend. 

2. Describe how to edit graph data values. 

 

 

WEEK THREE                    DATE: …………………. 

THE WORKSHEETS I 

Definition of Worksheet: A worksheet is a collection of cells organized into rows and columns 

where data is stored and manipulated. A worksheet begins with row number one and column A. A cell 

is a space in a worksheet formed by the intersection of a row and a column. Each cell can contain a 

number, text or formula. A cell can also reference another cell in the same worksheet, the same 

workbook or a different workbook. Each cell has an address called cell reference e.g. A1, B3, C7 etc 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: There are 1,048,576 rows and 16,384 columns per worksheet. 

 

 

 
Microsoft Excel worksheet 
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Starting Worksheet (Using Microsoft Excel) 

 Click Start button 

 Click All Programs 

 Click Microsoft Office 

 Click Microsoft Office Excel 

 

Entering data in a worksheet 

i. Locate the cell where you want to enter data on the worksheet and click on the cell. For example 

point and click on cell A1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

ii. Type in your entry from the keyboard and notice the appearance of the entries in the formula 

bar with the cell address. 

iii. Press ‘Enter’ key 

 

Editing data in a worksheet 

Wrong entries may either be entirely re-typed or the particular cell/range of cells can be corrected.  

1. To retype: 

 Move the cell pointer to the cell to be corrected or re-type the entry and press ‘Enter’ 

2. To correct only the mistake: 

 Move the cell pointer to the cell and double click on the cell 

 Make the correction by inserting, deleting or retyping 

 Press ‘Enter’  

 

Saving a worksheet 

1. Saving for the first time: 

 Click on ‘Home’ button 

 Click ‘Save As’ button and wait for a dialog box to open. 

 Type in your desired filename (i.e. the name of the document )  

 Click ‘Save’ button or press enter on the keyboard. 

 

2. Saving while working (after the first saving) 

 Click on ‘save’ icon on the Quick Access tool bar or click on ‘office button’ to open 

the menu and click ‘save’ from the options. 

 

Retrieving a saved worksheet 

Retrieving a worksheet means to open an already saved worksheet from its location in the computer. 

This is usually done to view, edit or update the worksheet. 

 Load/start Microsoft Excel 

 Click on ‘Office Button’  

 Click ‘Open’ option from the list and wait for a dialog box to open. 
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 Navigate to the file you want to open and double click on it.  

 

Formatting Worksheet in MS Excel 

Formatting a worksheet simply means changing the appearance of your worksheet to make it more 

presentable, attractive and easy to read. Some formatting actions include the following; 

 

Copying data in a worksheet 

This is done when a cell or group of cell is copied or moved to another area of the worksheet or 

another document. To copy a cell, perform the following; 

 Highlight the cell(s) to be copied and click on the copy icon on the home tab. 

 Click on the new position where you want to paste the data. 

 Click on the paste icon on the tool bar 

 

Boldfacing (making text bold) 

 Select the range of cells that contains the data to be bolded 

 Click on the boldface icon on the ‘Font’ group of the home tab/menu 

 

Italicizing content of cell(s) 

 Highlight the cell(s) to be italicized  

 Click on the italicize icon on the ‘Font’ group of the ‘Home’ tab/menu  

 

Italicizing content of cell(s) 

 Highlight the cell(s) to be italicized 

 Click on the italicized icon on the ‘Font’ group of the ‘Home’ tab/menu 

 

Changing font types of cell data 

 Highlight the cells to be changed 

 Click on the ‘font arrow’ button in the font group of the home tab/menu and open the font list. 

 Select the font type desired 

 

Changing font size 

 Highlight the cells to be changed 

 Click on the font size button on the font group of the home tab/menu 

 

EVALUATION 

1. Define Worksheet. 

2. State the steps involved in starting a worksheet. 

 

GENERAL EVALUATION 

1. Define a cell. 

2. What does it mean to format a worksheet? 

3. How do you boldface a text in a cell? 

4. List 4 formatting actions in Excel worksheet. 

5. State steps involved in saving a worksheet for the first time. 

 

READING ASSIGNMENT 

Melrose Computer Studies for Junior Secondary Schools 3 Pg. 43 

 

WEEKEND ASSSIGNMENT 

1. ……… is a collection of cells organized into rows and columns where data is stored and 

manipulated. A. Worksheet B.  Graph  C.  Workbook   D. Chart 

2. …….. is a space in a worksheet formed by the intersection of a row and a column.  
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A.  Workbook B.  Sheet C.  Cell   D. Graph 

3. There are …….. rows per worksheet in Excel. A. 1,048,576 B.  1,048,765  C.  1,408,576 D. 1, 

323,111 

4. There are …….. columns per worksheet in Excel. A. 16,387 B.  16,384  C.  16,684   D. 13,123 

5.  The address of a cell is known as ………  A.  Cell space  B.  Cell reference  C.  Cell Menu  

D. Cell base 

 

THEORY 

1. State steps required to retrieve a saved worksheet in Excel. 

2. Describe how to copy data in a worksheet. 

 

 

WEEK FOUR        DATE::…………………. 

TOPIC: THE WORKSHEETS II 

Various kinds of mathematical calculations can be done using MS excel. Microsoft Excel is a 

spreadsheet package used mainly for mathematical calculations and numerical analysis. Examples of 

calculations that can be performed using MS Excel include; addition, subtraction, multiplication, 

division, average, etc 

Formulas are often used to carry out calculations in ms excel. The desired formula for any calculation 

must be preceded with an equal sign (=). 

 

Arithmetic operators used in ms excel 

+  Addition   -  Subtraction 

/   Division    *  Multiplication 

^  Exponential 

When creating a formula, you must know MS Excel’s order of operations. Certain operations are 

performed before others. The term PEMDAS is the acronym to denote MS Excel’s order of 

operation. 

P ------ Parenthesis (Bracket) 

E ----- Exponential 

M ----- Multiplication 

D ----- Division 

A ----- Addition 

S ------ Subtraction  

Calculations enclosed in parenthesis are performed first, followed by calculations involving 

exponentials. Multiplication and division operations are performed next because they are considered 

equal in importance. They are performed in the order in which they are encountered from left to right. 

Addition and subtraction are performed last in the order in which they are encountered from left to 

right. 

Formulas in MS Excel 

Examples: 

Addition =C3+D3   Subtraction =C3-D3 

Division =C3/D3     Multiplication =C3*D3 

Average =AVERAGE(C4..C9) 

NOTE: ANY CELL(S) CAN BE USED APART FROM THE ONES USED IN THE 

INSTANCES BELOW 

 

Addition 

To add two numbers on a worksheet: 

 Enter the first number in cell C3  

 Enter the second number in cell D3 

 Type in =C3+D3 into cell E3 and press Enter. The result of the calculation will be displayed.  
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Subtraction 

To subtract two numbers on a worksheet: 

 Enter the first number in cell B4 

 Enter the second number in cell D5 

 Type in =B4-D5 into cell E6 and press Enter. The result of the calculation will be displayed. 

 

Multiplication 

To multiply two numbers on a worksheet: 

 Enter the first number in cell A2 

 Enter the second number in cell E3 

 Type in =A2*E3 into cell G3 and press Enter. The result of the calculation will be displayed. 

 

Division 

To divide two numbers on a worksheet: 

 Enter the first number in cell G6 

 Enter the second number in cell F1 

 Type in =G6/F1 into cell E3 and press Enter. The result of the calculation will be displayed. 

 

Average 

To find the average of three numbers on a worksheet: 

 Enter the first number in cell J5 

 Enter the second number in cell J6 

 Enter the third number in cell J7 

 Type in =AVERAGE(J5:J7) into cell J8 and press Enter. The result of the calculation will be 

displayed. 

 

PRINTING EXCEL WORKSHEET 

To print a worksheet in ms excel: 

 Click on office button 

 Click on Print 

 Make the necessary adjustments in the print dialog box displayed 

 Select an option from the ‘print range’ section 

 Under ‘copies’, specify the number of copies you want to print 

 Click ok. 

 

EVALUATION 

1. List steps required in printing a worksheet in Excel. 

2. Mention five kinds of calculations that can be performed in MS Excel. 

 

GENERAL EVALUATION 

1. Write out arithmetic five arithmetic operators used in Excel and their symbols. 

2. List Excel’s order of operation. 

3. How do you boldface a text in a cell? 

4. List 4 formatting actions in Excel worksheet. 

5. State steps involved in saving a worksheet for the first time. 

 

READING ASSIGNMENT 

Melrose Computer Studies for Junior Secondary Schools 3 Pg. 51 

 

WEEKEND ASSSIGNMENT 

1. ……… is a collection of cells organized into rows and columns where data is stored and 

manipulated. A. Worksheet B.  Graph  C.  Workbook  D. All 
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2. …… is a space in a worksheet formed by the intersection of a row and a column.  

A. Workbook B.  Sheet C. Cell   D. Graph 

3. There are rows per worksheet in Excel. A.  1,048,576 B.  1,048,765  C.  1,408,576    

D. 1,303,303 

4. There are ………. columns per worksheet in Excel. A. 16,387 B.  16,384  C.  16,684   

D. 12,342 

5. The address of a cell is known as …….  A.  Cell space B.  Cell reference  C.  Cell Menu  

D. Cell base 

 

THEORY 

1. State steps required to add two numbers in Excel. 

2. State steps required to multiply two numbers in Excel. 

 

 

WEEK FIVE          DATE::………………….                                                

TOPIC: COMPUTER PROFESSIONALS 

Computer Professionals refer to a set of people who have undergone special training as regards the 

usage of computer in higher institutions or computer training centers. There are various categories of 

computer professionals such as: 

1. Computer Manager 

2. System Analyst 

3. Computer Programmer 

4. Computer Engineer 

5. Computer Operator  

6. Web Designer  

7. Computer Educator etc 

 Computer Manager: The computer manager heads the computer department and oversees 

the entire day to day running of the computer department. 

 System Analyst: A system analyst carries out feasibility study on a system. He is the person 

who thinks of likely problems that may arise from the various kinds of software and subsequently 

proffers solution to such problems. 

 Computer Programmer: is the person who writes computer programs according to computer 

hardware and software specification. 

 Computer Engineer: is involved in the design, planning, and maintenance of new computer 

machines and technology. He also handles a wide range of computer related projects by applying 

basic engineering principles and technical skills. 

 Computer Operator: is a person who used the computer system in the running of the daily 

processes in an organization.  

 Web Designer: is a person who designs and creates websites with the aid of a computer using 

contents such as images, audio, video etc 

 Computer Educator: A computer educator is a person who trains user to have knowledge of 

computer hardware and software. 

 

QUALITIES OF A GOOD COMPUTER PROFESSIONAL 

1. He must have the desire to diagnose and solve computer problems. 

2. He must be able to prioritize projects in case there are multiple projects to be delivered.  

3. He must be able to provide cost effective solution to computer problems. 

4. He must be detail oriented, analytical, and accurate in carrying out tasks. 

5. He must be willing to learn new things. 

6. He must be able to work as a member of a team. 

7. He must be able to communicate well and effectively with others. 
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EVALUATION 

1. Define Computer Professional. 

2. Mention seven examples of computer professionals. 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. Write short note on the following: A. Web Designer   B. System Analyst     C. Computer 

Programmer    

2.   What are the functions of computer programmers? 

 

READING ASSIGNMENT 

Melrose Computer Studies for Junior Secondary Schools 3 Pg. 65 

 

WEEKEND ASSSIGNMENT 

1. ………  heads the computer department and oversees the entire day to day running of the 

computer department. A. Computer Manager B. Computer Operator  C.  Computer 

Programmer D. All 

2. ……. is a person who trains user to have knowledge of computer hardware and software. 

A. Computer Manager B.  Computer Educator C.  Computer Programmer D. All 

3. …….. is the person who writes computer programs according to computer hardware and 

software  specification. A.  Computer Manager B.  Computer Educator C.  Computer 

Programmer  D. All 

4. ………carries out feasibility study on a system. A.  System Analyst B.  Computer Educator  

C.  Computer Programmer D. Computer operator 

5. …….. is involved in the design, planning, and maintenance of new computer machines and 

technology. A.  Computer Manager B.  Computer Educator C.  Computer Engineer    

D. Computer operator 

 

THEORY 

1. State steps required to add two numbers in Excel. 

2. State steps required to multiply two numbers in Excel. 

 

 

WEEK SIX                                                                          DATE:……………………     

TOPIC: COMPUTER PROFESSIONAL BODIES 
These refer to an organized group of computer professionals who have a common goal of promoting 

new developments in the field of computing and sharing valuable knowledge among members.  

There are lots of computer professional bodies in existence both locally and internationally. Some of 

them include:  

1. Nigeria Computer Society (NCS) 

Nigeria Computer Society is a group where people interested in computing technology within Nigeria 

gather to share ideas and knowledge. You can become a member by completing the form online at 

www.ncs.org  

2. Institute of Management Information System (IMIS) 

This institute is involved with teaching independent professionals current technologies in information 

management. It aims to see that information system management is recognized as one of the key 

professionals’ influence on the future of the world. 

3. The Computer Professional Registration Council of Nigeria (CPRCN) 

It is a corporate entity charged with the control and supervision of computing profession in the 

country. The computer professionals were established through Act No. 49 of 1993. 

4. Information Technology Association of Nigeria (ITAN) 

This body provides learning opportunities within the engineering, sciences, research and technology 

fields. The goal of ITAN is to ensure the growth of skill and knowledge among information 

technology professionals. 
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5. Nigerian Internet Group (NIG) 

It is the largest online community of youth interested in global issues and creating positive changes. It 

is non-governmental, non profit making organization with the primary objectives of promoting access 

to the internet.  

 

EVALUATION 

1. Define Computer Professional Bodies. 

2. Mention five examples of computer professional bodies. 

 

GENERAL EVALUATION/REVISION QUESTIONS  

Write full meaning of the following acronyms: A. NCS   B. IMIS     C. ITAN    D. NIG     E. CPRCN 

 

READING ASSIGNMENT 

Melrose Computer Studies for Junior Secondary Schools 3 Pg. 69 

 

WEEKEND ASSSIGNMENT 

1. Computer Professional Bodies are organized group of …… who have a common goal of 

promoting new developments in the field of computing and sharing valuable knowledge 

among members. A. Computer Managers B. Computer Professionals C. Computer People  

D. Computer Educator 

2. ……  is a group where people interested in computing technology within Nigeria gather to 

share ideas and knowledge. A.  ITAN  B. NCS  C. CPRCN   D. NIG 

3. …….. is a corporate entity charged with the control and supervision of computing profession 

in the country.    A.  CPRCN       B. NIG         C. NCS    D. IMIS 

4. ……… is the largest online community of youth interested in global issues and creating 

positive changes. A. CPRCN  B.   ITAN    C. NIG    D. IMIS 

5. ……… body provides learning opportunities within the engineering, sciences, research and 

technology fields.     A.   ITAN   B. NCS    C. IMIS       D. NIG 

 

THEORY 

Write short note on: A. ITAN.  B. NCS 

 

 

WEEK SEVEN          DATE:…………………. 

TOPIC: LOGIC CIRCUIT I. 

Logic is the science of thinking about or explaining the reason for something using normal formal 

methods. In computing, logical operations are performed using special electronic components 

connected together to form a circuitry.  

 

Definition of logic circuit: Logic Circuit is a computer switching circuit that consists of a number of 

logic gates and performs logical operations on data. 

 

Definition of logic gate: Logic gates are micro electronic devices which make logical decision and 

serve as the basic building blocks of a digital logic circuit.   

All digital systems can be constructed by using the basic logic gates. Logic gates can have one or 

more inputs and one output. In digital logic, only two states are allowed. These states include 0 or 1, 

ON or OFF, Yes or No, True or False, High or Low. 
There are three standard basic logic gates namely; 

1. AND gate 

2. OR gate 

3. NOT gate 

 AND gate 

This is a digital circuit which gives high output (1) if all the inputs are high, and low output (0) if one 
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or both of the inputs are low. A dot (.)  is used to show the AND operation. It behaves like a logical 

multiplication. 

                                                                   Symbol for AND gate  

 

 

 

 

 OR gate 

It is a digital circuit which gives a high output (1) if one or more of its inputs are high, and low output 

(0) if both of the inputs are low. A plus sign (+)  is used to show the OR operation. 

                                                                 Symbol for OR gate  

 

 

 

 

 NOT gate 

It is a digital circuit in which its output is the inverse of its input. It is also called inverter. It has only 

one input. 

                                                                   Symbol for NOT gate  

 

 

 

 

EVALUATION 

1. What is the meaning of logic? 

2. Define Logic Circuit. 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. Define Logic Gate. 

2. Mention the two states that can exist in digital logic. 

3. List the three standard logic gates 

4. Draw the symbols of the three standard logic gates. 

5. Which of the logic gate is called an inverter? 

 

READING ASSIGNMENT 

Modern Computer Studies for Junior Secondary Schools Book 3 by Dinehin Victoria Pg. 105 

 

WEEKEND ASSSIGNMENT 

1. ……. is the science of thinking about or explaining the reason for something using normal 

formal methods.   A.  Thought Science  B.  Logic       C. Thought Process    D. All 

2. In computing, logical operations are performed using special electronic components connected 

together to form a ….. A. Circuitry     B.  Logic  C.  Cell   D. Circuit 

3. ……. is a computer switching circuit that consists of a number of logic gates and performs 

logical operations on data. A.  Logic gate   B.  Logic circuit  C. Logical operation     

  D. Circuitry  

4. …….. are micro electronic devices which make logical decision and serve as the basic 

building blocks of a digital logic circuit.  A. Logical electronics B. Logical blocks  C.  Logic 

gates    D. All 

5.  In digital logic, only …… states are allowed. These states include 0 or 1, ON or OFF, Yes or 

No, True or False, High or Low.  A.  4  B. 2   C.   3    D.   6 

 

THEORY  

1. Write short notes on: A. AND gate  B.  OR gate  C.  NOT gate 

X 

Y 

Z = X . Y 

X  X 

X 

Y 

Z = X + Y 
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2.    Using diagram explain AND and OR gate. 

 

 

WEEK EIGHT                                                                            DATE:…………………. 

TOPIC: LOGIC CIRCUIT II. 

Definition: 

Truth table is a table that shows how a logic circuit’s output responds to various combinations of the 

inputs, using logic 1 for True and logic 0 for False.  

All permutations of the inputs are listed on the left, and the output of the circuit is listed on the right. 

The desired output can be achieved by a combination of logic gates.  

 

Truth Table for AND gate 

The output of AND gate is high (1) only when both inputs are high (1). If one of the inputs is low (0), 

a output is produced.  

 

 

 

 

 

 

 

Truth Table for OR gate 

The output of OR gate is high (1) if one or both inputs are high. The output is low only when both 

inputs are low (0). 

 

 

 

 

 

 

 

Truth Table for NOT gate 

The NOT gate has only one input. When the input is high (1), it gives a low output (0) and when the 

input is Low it gives a high output. The NOT gate is called an inverter because its output is always 

the inverse of the inputs. 

INPUT OUTPUT 

X  

0 1 

1 0 

EVALUATION 

1. Define Truth Table. 

2. Define Logic Circuit. 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. Define Logic Gate. 

2. Mention the two states that can exist in digital logic. 

3. List the three standard logic gates 

4. Draw the symbols of the three standard logic gates. 

5. Which of the logic gate is called an inverter?. 

 

READING ASSIGNMENT 

Modern Computer Studies for Junior Secondary Schools Book 3 by Dinehin Victoria Pg. 105 

INPUT OUTPUT 

X Y Z 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

INPUT OUTPUT 

X Y Z 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

 X 
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WEEKEND ASSSIGNMENT 

1. The NOT gate is also called …….. A. Inverter       B. NOT logic C.  NOT table  

D.NOR logic 

2. How many input does the NOT gate has? A. 3     B. 2      C. 1   D. 5 

3. The output of …… gate is high (1) only when both inputs are high (1). A. OR  B. AND  

C. NOT  D. NOR  

4. The output of …… gate is high (1) if one or both inputs are high. A. OR B. NOT  C. AND  

D.NOR 

5. For ……. gate, when the input is high (1), it gives a low output (0) and when the input is low 

it gives a high output.  A. OR  B. NOT  C. AND   D. NOR 

 

THEORY  

Construct Truth Tables for:  

A. AND gate 

B. OR gate 

C. NOT gate 

 

 

WEEK NINE                      DATE: ………………. 

TOPIC: COMPUTER GAMES. 

Computer game is a game played on a computer with the aid of a game control device such as 

joystick for entertainment and relaxation purposes.  

Computer games are also referred to as PC games or video games. There are several kinds of devices 

that can be used to play computer games. Some of these devices include: 

1. Joystick 

2. Keyboard 

3. Mouse 

4. Game pad (also called Joy pad) 

 

There are several categories of computer games available today. Some of these include: 

1. Strategy games 

2. Shooter games 

3. Racing game 

4. Sports games 

5. Educational games etc 

 STRATEGY GAMES 

Strategy game is a game that usually involves a player’s free-will and independent decision making 

skills in determining the outcome. Strategy games require internal free thinking and typically very 

situational awareness when played. Strategy games can be video or board game. 

Common examples include: Poker, chess, scrabble, monopoly, draught or checkers, solitaire etc. 

 

 SHOOTER GAMES 

This is a game type centered on gun and projectile weapon-based combat through a first-person or 

third person perspective. Examples include: Call of duty, Battlefield, Doom, Tomb raider, Grand 

Theft Auto 3, Resident evil 4 etc. 

 

 RACING GAMES 

Racing game is a type of game in which the player partakes in a racing competition with any type of 

land, air or sea vehicles. Examples include: Asphalt 8, Need for speed, GTR evolution, Road rash, 

Speed racing, Shift 2 unleashed, Burnout crash etc. 

 

 SPORT GAMES 

This is a video game that mimics or simulates the practice of sports. Sport games involve physical and 
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tactical challenges, and test the player’s precision and accuracy. Most sports games attempt to model 

the athletic characteristics required by that sport, including speed, strength, acceleration and so on. 

Examples include: Pro Evolution Soccer, Golf pro, FIFA 16, NBA 2k16, KO boxing, Tennis ace etc. 

 

 EDUCATIONAL GAMES 

Educational games are games explicitly designed with educational purposes, or which have related 

educational value. All types of games may be used in educational environment if designed for such 

purpose.  

 

This kind of game is created to help people learn about certain subjects, skills or concept. Typical 

examples include: Mavis Beacon typing tutor, Hangaroo, Learnalot, Math blaster, Urban jungle, 

Reader rabbit etc 

 

ADVANTAGES OF PLAYING COMPUTER GAMES 

1. Playing computer games is entertaining 

2. Educational games helps to make learning fun 

3. It can be used to teach different subjects in the school. 

4. It helps a person to develop the habit of concentration 

5. It fosters people’s interest in computer 

6. Playing computer game is an entertaining way of spending one’s leisure time. 

7. It helps to reduce stress and boredom 

 

DISADVANTAGES OF PLAYING COMPUTER GAMES 

1. It wastes someone’s valuable productive time. 

2. Frequent playing can damage computer keyboard. 

3. It leads to procrastination of important tasks. 

4. It can affect a student’s performance in school. 

5. It can affect an employee’s efficiency in the workplace. 

 

EVALUATION 

1.  Define Computer Game 

2. Mention four advantages of playing computer games. 

 

GENERAL EVALUATION/REVISION QUESTIONS 

1. State five disadvantages of playing computer games. 

2. What is the difference between strategy games and sport games? 

3. Mention five examples of educational games 

4. Mention five examples of racing games 

5. Mention five examples of shooter games 

 

READING ASSIGNMENT 

Modern Computer Studies for Junior Secondary Schools Book 3 by Dinehin Victoria Pg. 105 

 

WEEKEND ASSIGNMENT  

1. ……….game usually involves a player’s free-will and independent decision making skills in 

determining the outcome.  A.  Strategy B.  Skill  C. Shooter D. All 

2. ……….game is a game that mimics or simulates the practice of sports.  A.  Shooter  B.  Sport  

C. Educational    D. Strategy 

3. is a game played on a computer with the aid of a game control device such as joystick for 

entertainment and relaxation purposes. A. Computer game   B. TV game    C. Mouse game  

D. None 

4. Computer games are also referred to as ……. A. Fun games B. PC games C. Kid games   

D. Sport games 
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5. …………..game is centered on gun and projectile weapon-based combat through a first-

person or third person perspective. A.  Strategy        B.  Weapon     C.  Shooter   D. Sport  

 

THEORY  

1. Define Computer Game 

2. Briefly explain five types of computer games. 

 

 

WEEK TEN                                                                             DATE:…………………. 

TOPIC: COMPUTER VIRUS 

DEFINITION 

A computer virus is a program designed to spread itself (replicate) by infecting other executable 

programs or files. Virus programs are written by programmers to purposely destroy our files, 

software, applications and cause loss of data. Besides, new computer viruses are constantly being 

created by malicious computer programmers. Computer viruses attach itself to files and overwrites or 

otherwise replace the file or program. 

 

Computer virus began to spread rapidly in the mid-1980. In the early 1990’s, several companies 

began to sell another program to counter the destructive program called the anti-virus program. 

 

TYPES OF COMPUTER VIRUS PROGAM 

1. BOOT SECTOR VIRUS: This is the deadly virus because it affects the major part of the 

computer called the boot sector. The virus affects the boost sector of the computer system. Any time a 

floppy disk is inserted into the drive, the floppy boot sector is affected.  

2. FAT: This virus infects the file allocation table of a hard drive. This usually cause a loss of 

files that are on hard drives. 

3. MEMORY RESIDENT VIRUS: This virus when executed stays in the computer memory 

and causes the memory to operate at a low speed. 

4. DIRECTORY VIRUS: This virus changes the paths that indicate the location of a file. By 

executing a program which has been infected by the virus, you are ignorantly running the virus. 

5. POLYMORPHIC VIRUS: This deadly virus not only replicates itself by multiplying files or 

itself, it also changes the signature every time it replicates. This is more difficult for less sophisticated 

antivirus to counter it. 

 

Other Computer Virus Programs include: 

 Trojan Horse 

 Logic bomb 

 Stoned virus 

 Sparse infectors e.t.c. 

 

EVALUATION 

1. What is a virus? 

2. Explain FAT virus 

 

SOURCES OF VIRUS 

1. Files. 

2. Batch files. 

3. From the internet: online attachments. 

4. From a computer network. 

5. From illegal duplication of software. 

6. From external devices. 
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VIRUS WARNING SIGNS 

1. Your computer system becomes slow in operation. 

2. The computer hard drive may constantly run out of free space. 

3. Strange graphics, images are displayed on the monitor. 

4. Disks and drive are not accessible. 

5. Computer programs act unsteadily. 

 

WAYS TO PROTECT YOUR COMPUTER 

There are several things you can do that will help you protect your computer against viruses: 

1. Installation of anti-virus software. 

2. Scan your computer regularly. 

3. Update regularly your antivirus program. 

4. Have a backup (Corrective approach). 

5. Scan downloaded files before opening. 

 

ANTIVIRUS PROGRAM 

They include: Norton antivirus, McAfee antivirus, Dr. Solomon e.t.c 

 

GENERATION EVALUATION 

1. Write briefly on 

a. Directory virus 

b. Boot sector virus 

c. Fat virus 

d. Memory virus 

2. List ways you can protect your computer from been attacked by viruses. 

 

WEEKEND ASSIGNMENT 

1. A program that cause malfunctioning of the computer is called ………..A. acrobat B. virus  

C. software D. program 

2. Virus is a computer……….. A. component B. tool C. Software  D. None 

3. …………develop a computer program A. Computer student B. Computer Educator  

C. Computer operator D. Computer programmer 

4. You can protect your by……… A. downloading regularly. B. Switching off your computer 

regularly C. Scanning regularly D. Installing any software 

5. Computer anti-virus does…………… A. protect your computer B. increases the efficiency of 

your computer C. Helps in downloading files D. None 

 

THEORY 
1. List and explain THREE computer virus programs. 

2. Explain ways to protect your computer from attacks of viruses.  


